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PREMIER+™ – Lettering 

By Shawna Taylor 

Lettering options in our software has greatly 

evolved over the years. I remember when I 

was excited about the prospect of six styles of 

fonts. I imagined endless possibilities for my 

projects, utilizing those fonts.  

Many more styles of fonts are now available 

in the PREMIER+™ Embroidery System than 

in the optional embroidery systems of years gone by. Adjustments can be made to the size, 

texture, shape and more in the PREMIER+ Embroidery System—much more than we have had 

the ability to do in previous versions of software.  

There are two different ways to utilize lettering in the software. The Lettering tab has 

professionally digitized fonts in a variety of styles and categories. If you still cannot find the 

perfect font for your project, you can create your own embroidered lettering using the 

QuickFont feature.  

This lesson will focus on understanding how to make these adjustments and how some of the 

creative options work using the built-in fonts.  Ultimately, understanding how the lettering 

works will ensure quality embroidery stitching on your projects. 

Reset All Modules 

1. Double click to open the PREMIER+™ Embroidery System.  

2. Double Click to open PREMIER+™ Configure.  

3. Click the Reset All Modules button.  
4. Click OK through the prompts to return all modules to their original configuration.   
5. Click OK to close PREMIER+™ Configure.   

Lettering-Size Recommendation & Stitch Formation 

It is important to understand how a letter is stitched and the limitations of the fonts to ensure 

quality stitching.  

1. Double click on PREMIER+TM Embroidery . 

2. Click Change Hoop  from the Home ribbon bar. 
3. Set the hoop size to Hoop Group: Universal, Hoop Size: 100mm x 100mm – Universal 

Square Hoop 1. 
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4. Verify orientation is set to Rotated, and 
click OK. 

5. Click the Letter tab. 
The first section of the Letter tab contains 
the Font tools. From here, you can choose 
the style of lettering from the built-in fonts 
or there is a QuickFont tool that will enable 
you to create your own embroidered lettering using TrueType or OpenType fonts on your 
computer.  
The default font is Georgia 20-40mm. There are many more font options available. 

6. Click the Show All  button to view all of the built-in fonts. 
The fonts are organized into categories and can be viewed by using the scroll buttons at 
the side of the font menu. You can also use the Page Up or Page Down buttons on your 
keyboard or even the arrow up and arrow down buttons for a more controlled view.  
PREMIER+™ Intro has 13 fonts, PREMIER+™ Embroidery and PREMIER+™ Extra has 155+ 
fonts and PREMIER+™ Ultra has 170+ fonts. 

7. Select Georgia 08-20mm from the Traditional category.  
Every built-in embroidery font has a recommended size to 
ensure optimum embroidery results. The size relates to the height of the capital A for each 
font. The recommended sizes are clearly stated in the name of the font. It is not a good idea 
to ignore these recommendations. If you do, it would be advisable to test the embroidery prior 
to embroidering onto your project.  
Notice how the size defaults to the smallest size in the recommended size range. 

8. In the Letters box, type a capital ‘W’. 
9. Change the size to 20mm.  

10. Click Apply . 
This particular font has been digitized for two different 
size ranges. In order to understand these size recommendations, it is important to see how 
the stitches are created. 

11. Select Georgia 20-40mm. 
The size defaults again to the smallest size in the recommended size range. 

12. Leave the size at 20mm and click Apply . 
13. Move the second letter so it is below the first letter. 

Let’s take a closer look at these two letters. 

14. Zoom in on the two letters by using Zoom to Rectangle  located in the bottom right 
corner of the hoop area.  
Notice how the mouse pointer becomes a magnifying glass. This tool allows you to zoom 
in on a very specific area very quickly. 

15. Move your mouse pointer above the first letter and a little to the left. 
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16. Hold down on the left mouse button while dragging the mouse to the lower right of the 
second letter. Once the zoom box is around both letters, release the left mouse button. 
If you want to zoom back out quickly or need to try this Zoom to Rectangle tool again, 

choose Zoom to Fit , and then trying zooming in again. You can also use some of the 
other Zoom tools available in the same area of the screen. 

17. Click the View tab. 
18. Change the View Mode to 2D View.  

Now we can see how these stitches are created and the foundation or underlay stitches 
built in to the letter.  

19. Click on Design Player  from the Quick Access toolbar located in the upper left corner 
of the screen. 
The first letter is made to be 8mm up to 20mm. The serif of the letter (the line across the 
top of the W) is created with long satin stitches going the same direction as the other 
stitches which make up the letter. 

20. Click Play  to see how the first letter W is formed. 
A single stitch travels from the bottom of the W up to the first serif. The stitches 
then go across, from right to left, to create the serif. As soon as the serif is 
created, the satin stitch to create the rest of the W continues.  
Notice how the points of the W are stitched, with a slight overlap as the satin 
stitch goes another direction. There are no underlay stitches involved to 
support the lettering. 
As the letter continues to be stitched, eventually a single stitch travels up 
to the other serif at the top of the W. It is created the same as the first 
serif. The satin stitch continues to the bottom right point of the W 
completing the letter. 

21. As the Design Player continues, notice how the second W is created. 
A series of single stitches are done on the outside edges of the letter. This 
style of underlay is called Edge Walk. These stitches will help support the 
satin stitches.  
A small section of satin stitches are placed at the bottom of the left leg on 
the W to prepare for turning that corner. Next, a series of zig zag stitches travel up to the 
top left serif of the W. These stitches will also provide support for 
the final satin stitches. 
The first serif is created using vertical satin stitches before the 
stitches rotate and go from left to right to create the left leg of 
the W. Additional zig zag stitches travel the rest of the letter W, changing 
to a satin stitch for a small section, before finally creating the serif on the 
top right. Once that serif is completed, there are satin stitches with 
occasional traveling stitches placed to finish out the letter. 

22. Click Cancel to close the Design Player. 
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23. Click on the first letter W (the one created using Georgia 8-
20mm). 
Notice on the Design Panel, the number of stitches to create 
this single letter. This letter consists of 367 stitches. 

24. Click on the second letter W (the one created using Georgia 20-
40mm). 
Notice on the Design Panel, the number of stitches to create 
this single letter. This letter consists of 793 stitches.  

 
Small fonts, like the first letter W, are typically not as dense as larger 
fonts. This can easily be seen in the image to the right. The top letter is 
created for smaller font sizes while the bottom letter is created for larger 
font sizes. 

Smaller fonts are also digitized to create less bulk or stitch build up in the 
corners and points of the letters. We saw this while watching the Design 
Player earlier. 

Another noticeable difference is the amount of underlay, or perhaps the 
lack of underlay, found in the smaller fonts. The only stitches under the 
satin stitches on the first letter we tested were the traveling stitches. In contrast, the second 
letter W not only has edge walk underlay, but also zig zag underlay and extra support stitches 
at the points. Even the serifs stitch in a different direction on the second letter to prevent the 
satin stitches from being too long. 

Why is this important to know? If you use a font that is designed to be done in a larger size 
range and change the size below the recommended amount, it may result in ruining your 
project by creating holes or wads of stitches in the points. By the same token, if you use a font 
that is designed to be done in a smaller size range and change the size above the 
recommended amount, it may result in wavy stitches or the stitch quality compromised on 
your project. This is due to the lack of support or underlay stitches in small fonts. 

Lettering-Motif Line Font 

1. Click the File tab. 
2. Select New to open a fresh page. 

This will clear the screen of the letters we have up 
now and give us space for a new project. 
If prompted to save, say No. 

3. Click the Letter tab. 

4. Click on the Show All  button to view all of the 
built-in fonts. 

5. Scroll to the Applique category, which is the first category listed. 
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Along with the name of the font and the size recommendation, there are some 
abbreviations which give more information about that particular font. For instance, when 
you see a UC in the name of a font, this means the font only has uppercase letters. Even if 
you type lowercase letters into the text box, the software will automatically convert the 
lowercase letters into uppercase letters when you click Apply. Some common font types 
include UC uppercase only font, LC lowercase only font, 2C two color font, 3C three color 
font and NP nearest point font. 
There are additional font types for Super Fonts. A list of these abbreviations can be found 
on page 298 of the PREMIER+™ Embroidery Reference Guide. A Super Font allows for 
more personalization in the look of the stitches. For instance, in the Applique category, 
there are a couple of fonts that have an ML in the font name. This stands Motif Line. You 
are able to change the stitch that makes the outline around the letters. 

6. Click the View tab. 
7. Change the View Mode to 3D View.  

8. Click Change Hoop  from the View tab. 
9. Set the hoop size to Hoop Group: Universal, Hoop Size: 360mm x 200mm – Universal 

Large Hoop 4. 
10. Verify orientation is set to Rotated, and click OK. 
11. Click the Letter tab. 

12. Click on the Show All  button to view all of the built-in fonts. 
13. Select Rian Patch 35-70mm ML from the Applique category. 

For PREMIER+™ Embroider/Extra software, choose Bell Patch UC 35-70mm ML. 
14. Type a C in the text box. (Since this is a UC font, it doesn’t 

matter if you capitalize the letter) 

15. Click Apply . 
The letter is a little smaller than I would like, so let’s change the size. 

16. Right click on the letter and choose Properties. 
Many adjustments can be made in the Letter Properties window. Although we will not be 
doing anything other than change the size, take a look at the options. 

17. Change the size to 55mm. 
18. Click OK to apply the change. 
19. Using the Zoom tools, zoom in closer to the letter C.  
20. Right click on the letter and this time choose Applique 

Fabric. 
The Applique Selection window has many choices. If 
you want to change the fabric used in the applique, this 
is the place to do it. We only want to make one adjustment at this time. 
Notice how the edges of the applique fabric extend past the stitching. You have the ability 
to adjust the amount of fabric left in the margin. 

21. Change the Applique Piece Margin to 0.3mm and click OK. 

1.0 mm 
Margin 

0.3 mm 
Margin 
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Now there is not as much fabric sticking out of the edges.  
To learn more about the other options in the Applique Selection window, click the Help 
button in the lower right corner of the window. This will open window from the section of the 
Reference Guide that applies to the Applique Selection window. 

22. Right click on the letter C and select Motif Line. 
23. Change Group to Husqvarna Viking. 

There are several stitch groups to choose from including My Motif (motifs 
you create yourself in other modules), Husqvarna Viking machine stitches, 
Pfaff machine stitches and Universal stitches. 

24. Select Category: D3 Heirloom, Pattern: 8, Height: 5.6, Width: 4.8 and 
verify Fit to Line has been selected. 

25. Click OK to close the Motif Line window. 
The look of the letter has been completely changed by choosing a different motif line.  

26. Click Zoom to Fit  to see the entire hoop. 
27. Move the C so that it is centered in the hoop but all the way to the left. 

We are going to make the word CREATIVE out of several different styles of fonts. We will need 
the entire width of the hoop to fit the word. 

Lettering-Crosshatch Fill Font 

1. Select Inform Patchwork UC 50-120mm XH from the 
Display category.  

2. Type a R in the letter box. 

3. Change the size to 55mm and click Apply . 
4. Right click on the letter R and select Crosshatch Fill. 
5. Change the Gap to 6.0 mm and click OK. 

There are lots of other adjustments that could be made to the 
crosshatch fill. Feel free to try some things until you get the 
look desired.  
As with any other window, there is a Help key in the bottom 
right that gives detailed information about all of the options on 
this window.  

6. Move the R next to the previous letter. 

Lettering-Multicolor Gradient Pattern Fill Font 

Fonts created with a Pattern Fill have some interesting design options. Not only can you 

change the texture or pattern fill of the font, you have the ability to add additional color 

gradient options to the font. There are many creative color options when additional color 

markers are added to a font. Let’s see how this works. 

1. Select Stencil UC 15-100mm from the Display category.  
2. Type an E in the letter box. 

3. Change the size to 55mm and click Apply . 
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4. Right click on the letter E and select Pattern Fill. 
There are over 250 pattern fills to choose from to 
change the look of the font.  

5. To view all of the pattern fill choices, click the 

Show All  button. 
6. Select pattern fill 76 from the Circles 2 category. 
7. Change the angle to 202. 
8. Place a checkmark in the Gradient box.  

This will give you additional options in the lower 
half of the Pattern Fill window. 

9. Select Multicolor Gradient. 
10. Click Add Marker to end up with a total of 3 color 

markers. 
The position of the color markers (located below 
the gradient bar) can be moved to change the 
fading from one color to the next.  
Adjustment markers (the small triangles above the 
gradient bar) can be moved to change the intensity of the fading from one color to the 
next. 

11. Double click on the first color marker and change the color to a coral shade then click OK. 
12. Double click on the second color marker and change the color to a lavender shade then 

click OK.  
13. Double click on the third color marker and change the color to a light yellow shade then 

click OK. 
14. Now move the three color markers into different positions until you like the final result. 
15. If desired, move the adjustment markers to change the look. Click OK to see the result. 

If you want to make more adjustments, simply right 
click on the letter E and choose Pattern Fill to open 
the Pattern Fill window for additional adjustments. 

16. Move the letter E next to the previous letter. 

Lettering-Fun Font 

There are a couple of fonts that are fun to incorporate into projects.  
1. Select Animal Magic 45-120mm from the Children category.  
2. Type a capital A in the letter box. 

3. Change the size to 55mm and click Apply . 
All the letters in this font are in the 
shapes of animals. 

4. Move the letter A next to the previous 
letter. 
HOMEWORK: 
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LOW MED HIGH 

Try out some of the other fun fonts. In the Children category, there is a font called Cheese and 
Mice. The letters look like pieces of Swiss cheese and numbers 0-9 will give you mice in 
different poses. Another interesting font is found in the Fun category and it is called Archery. 
The uppercase letters are made with bows, targets and some arrows. The lowercase letters 
and numbers are made with arrows. 

Lettering-Changing Patten Fill Fonts 

Many of the fonts included in the software are created using pattern fills. There is a default 

pattern selected but with over 250 pattern fills to choose from, you can completely change the 

look of the font. 

1. Select Woodblock UC 30-100mm from the Wild West category.  
2. Type a T in the letter box. 

3. Change the size to 55mm and click Apply . 
4. Move the letter T next to the previous letter. 
5. Right click on the letter T and select Pattern Fill. 

This letter has two different pattern fill sections. Pattern Fill 1 will change the shadowed 
part of the letter. Pattern Fill 2 will change 
the face of the letter. 

6. Select Pattern Fill 2. 
7. To view all of the pattern fill choices, click the 

Show All  button. 
8. Select pattern fill 209 from the Squares 2 

category. 
9. Change the angle to 270.  

Underlay is another option in the Pattern Fill 
window. This particular font defaults at a Medium density underlay.  
Underlay is a low density fill that is 
perpendicular to the stitches of the actual 
fill area. Underlay is useful for stabilizing 
large fill areas. 
Here are some examples of what the 
different settings of underlay look like. 
None will not place any underlay stitches 
beneath the fill stitches. Low will give 
some stitches with gaps between the 
rows of stitches. As you change to Medium or even High underlay, the rows of stitches get 
closer together, providing additional support to the fill stitches.  
If you are not sure which Underlay to select when stitching a dense pattern fill letter, it is 
better to have too much underlay rather than not enough. 

10. Click OK to close the Pattern Fill window. 
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11. Right click on the letter T and select Pattern Fill. 
12. Select Pattern Fill 1. 

This will change the pattern of the shadowed part of the letter. 
13. To view all of the pattern fill 

choices, click the Show All 

 button. 
14. Select pattern fill 18 from 

the Standard 2 category. 
15. Change the angle to 195.  
16. Click OK to close the Pattern Fill window. 
17. Select Spooky UC 15-100mm from the Scary category.  
18. Type an I in the letter box. 

19. Change the size to 55mm and click Apply . 
20. Move the letter I next to the previous letter. 

The tree bark pattern looks nice but is a little large for the size of the letter. Let’s see if we 
can find something a little better. 

21. Right click on the letter I 
and select Pattern Fill. 

22. Select pattern fill 167 from 
the Plants & Flowers 1 
category. 

23. Verify the angle is set at 0.  
24. Click OK to close the Pattern Fill window. 

Lettering-Foam Fonts 

One entire category of fonts found in the software work in conjunction with Puffy Foam. The 
result is a three-dimensional effect. Puffy Foam from 2.0mm to 6.0mm thickness can be used. 
These fonts have been created specifically to perforate the foam around the edges so that the 
excess foam can be removed cleanly. Using the Design Player, we will be able to see exactly 
how to stitch a Foam font. 
1. Select Athletic Block Foam 2C UC 40-50mm from the Foam category.  
2. Type a capital V in the letter box. 

3. Change the size to 50mm and click Apply . 
4. Move the letter V next to the previous letter. 

This letter is a little shorter than the rest of the letters 
since the largest recommended size is 50mm. The letters 
can be adjusted using the Height and Width settings. 

5. Right click on the letter V and select Properties. 
6. Change the Height to 110.  
7. Click OK to close the Letter Properties window. 
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To see how the foam fonts actually stitch, we will open a new window with a foam font and 
use the Design Player.  
8. Click the File tab. 
9. Select New Window to open a second page. 

This will not close the current window. Instead a second window will open without 
disturbing our current project. 

10. Click Change Hoop  from the Quick Access Toolbar.  
11. Set the hoop size to Hoop Group: Universal, Hoop Size: 100mm x 100mm – Universal 

Square Hoop 1. 
12. Verify the orientation is set to Rotated, and click OK. 
13. Click the Letter tab. 

14. Click on the Show All  button to view all of the built-in fonts. 
15. Select Athletic Block Foam 2C UC 40-50mm from the Foam 

category.  
16. Type a capital V in the letter box. 

17. Change the size to 50mm and click Apply . 
Notice in the Color Select area of the Design Panel there are three 
colors for this single letter.  
Color 1 is a running line to show where to position the puffy foam. 
Color 2 will stitch down the puffy foam as signified by the symbol next to the color. This 
will also do the satin stitch which covers the puffy foam. Excess foam will then be removed. 
Color 3 in this particular font is the narrow satin outline around the letter.  

18. Select the Design Player  from the Quick Access Toolbar located in the upper left 
corner of the screen. 

19. Click Play  to see how to embroider this type of font.  

  
 

The placement line for the foam is 

stitched with color 1 and then the 

machine stops. Place the foam on top 

of the placement line. 

Using color 2, the foam is stitched 

down and a satin stitch is embroidered 

on top of the foam. The machine stops 

to remove excess foam. 

Color 3 is placed on the machine to 

embroider the narrow satin stitch 

around the outside edges of the 

letter. 
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20. Click Cancel to close the Design Player. 
21. Double click on color number 2. 

Not only can you change the color of the stitches, the thickness of the foam can be 
adjusted here. 

22. Change the Puffy Foam to 2 mm. 
23. Click OK to close the Color Selection window. 

24. Close this window by clicking on the  in the upper right corner of the window. 
25. When prompted if you want to save changes, say No. 

We should now be back at the original window with all of the letters we have been 
creating. Only one more letter to go! 

 

Lettering-Satin Column Fonts 

A new feature in the PREMIER+™ Embroidery System is the ability to change the pattern of 
a satin letter. The great thing about this ability is that the pattern actually follows the curves of 
the letter instead of just being stamped across the letter. You will be able to see what I mean 
as we create our final letter. 
1. Select Braid 30-80mm from the Script category.  
2. Type a capital E in the letter box. 

3. Change the size to 55mm and click Apply . 
4. Move the E next to the previous letter. You should now have the word CREATIVE. 

The default Satin Column pattern makes the letter look like it is created with a rope. Let’s 
try another pattern to see how these Satin Columns work.  

5. Right click on the letter E and select Satin Column. 

6. To view all of the column choices, click the Show All  button. 
There are over 250 patterns to choose from. 

7. Select pattern 48 from the Animals 1 category. 
8. Click OK to close the Column window. 

This pattern shows how it shapes to the curve of the letter. 
9. Right click on the letter E and select Satin Column. 
10. Select pattern 62 from the Circles 1 category. 
11. Click OK to close the Column window.  

Again, the circles follow the curves of the letter. 
12. Continue to try some other patterns until you find one you like. 

 I selected pattern 72 for my letter. 

default 48 

62 72 
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Lettering-Alignment 

Now that our word is complete, it is time to make sure the letters are aligned. Although you 

could manually move every letter, there are time saving tools at your fingertips. 

1. Click on the Home tab. 

2. Click on Select All  from the Select tools. 
This places boxes around every individual letter as well as one 
box with gold corners around the entire word. 

3. Select Alignment, Vertical Alignment and then Align Middle 
from the drop down menus. 
This will make the center point of the letters all line up perfectly. Now we need to center 
the word in the hoop. 

4. Select Alignment and then Center in Hoop. 
While all of the letters are selected, we need to Group the letters together to make it easier 
to make adjustments to the rest of the project. 

5. Click Group  to group the selected design together to make it easier to move, resize, 
rotate, etc. 

6. If any color changes are desired for the letters, now is great time to do so since they are all 
grouped together in the Color Select section of the Design Panel. 

Lettering-Saving the Word 

Before we finish creating the rest of the design, it is a good idea to save our work. The best 

way to do this is in VP4 format, which will keep every letter separate, in case we want to make 

changes or adjustments later. 

1. Click Save As   from the Quick Access Toolbar. 
2. In the Save As window, browse to Documents/Premier+/My Designs.  
3. Choose New Folder to create a subfolder in My Designs called Classes and press Enter.   

If you already have a folder called Classes, skip this 
step and select the Classes folder. 

4. In the File Name box, type ‘creative’ and verify the 

file type is .vp4 and click Save .  

Finishing the Design 
1. Click the Letter tab. 

2. Click on the Show All  button to view all of the built-in fonts. 
3. Select San Fran 15-60mm from the Retro category. 
4. Type ‘Do something’ in the text box. 
5. Change the size to 40mm. 

6. Click Apply . 
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7. Move the words so they are above the word CREATIVE. 
8. Delete the words from the text box and type in ‘every day!’. 
9. Change the size to 45mm. 

10. Change the Line Type to Fit to Wavy Line . 

11. Click Apply . 
There are 5 green square boxes that can be moved to change the shape of the line. The 
green circle signifies where the word will start and can be moved anywhere on the line. 

12. Move the green square 
boxes to create a nice wave 
for the words to follow. 

13. Move the green circle until 
the word looks good to you. 

14. Move the words into 
position by placing the 
mouse pointer on the word, away from a green boxes or green circle. Make sure no part of 
the word is outside the gridded area. If the line is outside of the gridded area, it will be fine.  

This particular font has the ability to change from a smooth satin stitch to a different satin 
column pattern. The balls on some of the letters are a fill pattern, so they can also be changed 
to a more textured look, if desired. 

Saving & Exporting the Design 

It is always a good idea to Save your project as a VP4 file and then when you are ready to 
embroider your design, choose to Export the design into the format your machine requires. 
Saving the design as a VP4 file does not combine any of the design elements so it is easy to 
load the design at a later time to make adjustments or changes. When a design is exported, all 
of the separate design elements are combined together into one element. You can also 
ColorSort, remove any overlapping stitches and optimize the design for the best stitch results. 

1. Click Save As   from the Quick Access Toolbar. 
2. In the Save As window, browse to Documents/Premier+/My Designs/Classes (or wherever 

you have saved the files created for this exercise).  

3. Name the file ‘Do Something’  

4. Verify the file type is .vp4 and click Save 

. 

5. Click the Export  icon from the Quick 
Access Toolbar. 
Notice how the software automatically 
rotates the design to fit into the natural 
hoop rotation. 
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6. Verify the file format is .vp3 and then click OK .   
7. In the Save As box, the file name should 

automatically be generated to say ‘Do 
SomethingExported’.  

8. Browse to: Documents/Premier+/MyDesigns/Classes (or wherever you have been saving 
the files for this exercise). 

9. Click Export  to place the exported design in the Classes folder. 
10. When ready to embroider this design, simply save the exported version to USB stick. 
 

Some additional font styles we did 
not explore in this lesson include 
the fonts found in the Effects 
category. These fonts are designed 
to be done using optional 
accessories like the felting kit, twin 
needles or even a wing needle. To 
learn more about these fonts, be sure to refer to the embroidery reference guide. 
 
I hope you enjoyed learning a little bit more about some of the lettering options in the 
PREMIER+™ Embroidery System. Keep in mind that if you still do not find the perfect font, 
you can always create your own font using the QuickFont module.  
Most importantly, do something creative every day in your software! 
 

 


